
RELEASE NOTES

Release Notes for Modo16.1v1

Release Date
15th February 2023

System Requirements

Note: Modo 16 scenes are not compatible with earlier releases due to a change in the Modo
LXO scene format. If you need to load a Modo 16 scene in an earlier version of Modo, please
go to the Previous Download link for Modo page or contact support@foundry.com to
download Modo 15.2v4, which can read Modo 16 scenes and convert them for use in earlier
versions of Modo.

Officially Supported Operating Systems
• macOS 11.x (Big Sur), 12.x (Monterey), and 13.x (Ventura)

Note: Modo has been tested and validated on Apple Silicon hardware, running under
Rosetta 2 emulation.

• Windows 10 and Windows 11 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7.6+)
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Note: For Ubuntu 20.04 or 22.04 installs (which have not been validated by formal QA
testing), additional libraries need to be installed for Modo to work. From the terminal issue
the following two commands, to prevent a crash on launch:
sudo apt-get install libxcb-xinerama0
sudo apt-get install libxcb-xinput0

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher

• 10 GB available hard disk space (for a full Modo and content installation)

• At least 2 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of GPU
memory and drivers that support OpenGL 4.4 or higher

• AMD AI Denoiser requires a minimum of 4 GB of GPU memory

Recommended System Requirements

Note: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*

• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

Recommended Graphics Driver Versions
• NVIDIA: 461.09 or later

• AMD: 8.982.8.1 or later
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Note: We recommend downloading the latest driver version from the NVIDIA or AMD
websites.

Tested Workstation Hardware

The configurations listed below are those that Foundry have tested with Modo 16.1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, Foundry is
unable to officially certify hardware. The list below can be used as a recommendation and does not
guarantee that it meets your particular needs.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

Tested Workstation Hardware

Apple • Mac Mini (M1, 2020)

• MacBook Pro (Retina, 15-inch, 2018)

• MacBook Pro (Retina, 15-inch, 2017)

CPU • Intel i7-8700

• Intel i9-9900k

• Intel Core i7 10750H

• Intel Xeon E3-1505M v6

• Intel Xeon E5504

Tested GPU Hardware

AMD Enterprise Graphics Cards • Radeon Pro WX 8200

• Radeon Pro WX 7100

• Radeon Pro 560X

• Radeon Pro W6600

NVIDIA Prosumer Graphics Cards • GeForce GTX 1070 Ti (Linux)

• GeForce 2070 Super

NVIDIA Enterprise Graphics Cards • Quadro T1000
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New Features and Enhancements

Detail and Bake to Your Models: The Decal Workflow

Add Complex Details to your Model with Planar Decal Workflows

In Modo 16.1, you can place and layer images anywhere on the surface of a model. With Planar
Decals, placing images on 3D surfaces can be done with minimal distortion and without having to edit
the UVs for the surface. Inspired by game workflows, the Planar Decal Mesh Op allows you to apply
planar decals as presets on the surface of models, showing you what a decal will look like when
applied in-game.

See Add Complex Details to Your Model with Decal Workflows for more information.

Add Seams to Models with Intersecting Geometry Using Seam Decals

No more modeling effort when creating seams on a model. Modo 16.1 brings Seam Decals, a feature
that enables users to draw a curve on a surface and create an image-based seam that produces the
illusion of a complex model without actually having to model the details. With its game-inspired
application, the seam decal MeshOp can be used by artists on hard surface models with a lot of
panels and nurnies.

See Add Seams to Models With Intersecting Geometry and Seam Decals for more information.

Render and Bake Decals Using Surface Probes

Reach the final asset quicker and effortlessly, and make the decal part of the main surface. Introduced
in Modo 16.1, the Surface Probe can be used for projection from floating decals onto a receiving
surface. The full set of effects on the specific texture can then be rendered on that receiving surface,
automatically eliminating all of the floating decals.

See Render and Bake Decals Using Surface Probes for more information.

Easy Mesh Placement with Mesh Paint

Modo 16.1 brings enhancements to Mesh Paint, a tool that enables users to place meshes on the
surface of another mesh. With this release, Mesh Paint is more reliable and artists can now define
which mesh is being placed on without having to select it. The introduction of the new Edit Mode in
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Mesh Paint Replica makes placing and orienting items on existing meshes effortless while the latest
updates also allow for editing placement.

See Create and Hand Paint Decals With Mesh Paint Replica for more information.

Smart and Beautiful Advanced Viewport

See Curve Forms at a Glance with Curvature Shading

The second release of the Modo 16 series brings greater visibility with the new Viewport Curvature
Shading feature. It’s now easier for artists to better understand the forms they create as the Curvature
Shading brightens the high areas and darkens the low areas. For a more informed modeling
experience, this feature can simply be toggled on by any 3D artist or designer.

See Advanced Options for more information.

Create Shapes with Confidence Using Curve and Edge Width Display

Easily discern curves and edges in the Viewport with Modo 16.1. The Viewport Curve and Edge Width
Display enable artists to modify the width of important components of modeling. With this addition,
3D artists and designers are better informed about what shapes they are creating, giving them more
control and visibility.

See Active Meshes and Inactive Meshes for more information.

Improved Real-Time Visualization in the Advanced Viewport

As of Modo 16.1, the quality improvements of the Advanced Viewport make it a much more desirable
choice than your usual Default Viewport. Transparency quality has been considerably improved and
users can now benefit from higher performance. By using the Advanced Viewport feature, artists can
achieve better real time visualization of transparency.

See 3D Viewport Styles for more information.

Uninterrupted Viewport Modeling with Improved Planar Projection

When projecting a planar texture onto a surface, your Viewport usability shouldn’t be affected. That’s
why, as of Modo 16.1, artists can benefit from dramatically improved the performance of planar
projections, allowing for a cursive workflow without interruptions. Users are now more informed
during the process of modeling.
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See Projecting Decals with Planar Decals for more information.

Improve Viewport Response Times Using the Light Illumination Toggle

Placing multiple lights in a scene shouldn’t cause any slowdowns. That’s why, in Modo 16.1, you can
make use of the new Viewport Light Illumination Toggle, a feature that allows you to clearly see the
light items without having them actually cast light on a scene. Turn all the lights off without having to
worry about light items being hidden from the Viewport.

See Visibility for more information.

Render Faster with mPath Acceleration

Faster Rendering with mPath Using NVIDIA CUDA GPU Support

Forget long waiting times for rendering with the introduction of NVIDIA CUDA GPU Rendering.
Brought to you in Modo 16.1, this feature adds GPU computing to the shading side of mPath to help
accelerate rendering. Spend less time waiting and enjoy faster rendering.

See mPath Settings for more information.

Improved Rendering Quality and Speed with Metal on macOS

For any artist using Apple hardware, Modo 16.1 brings good news, better support, and faster
rendering. With the Metal Ray Tracing support for macOS, users can expect speed increases between
20% and 100% when compared with Foundry SSE. The second release of the Modo 16 series brings us
a step closer towards fully supporting M1 and M2 Macs.

See mPath Settings for more information.

Add Materials to Models Without Creating UVs Using Triplanar
Projection

Adding materials to a surface doesn’t need UVs anymore. In Modo 16.1, we’re introducing Triplanar
Texturing, a feature that projects textures onto a surface from multiple angles. When these textures
overlap one another, Triplanar Texturing blurs and blends them, giving the impression of a single
consistent feature over the surface. Artists can now quickly add a worn metal material to a complex
surface without having to worry about creating UVs.

See Texture Locator Properties for more information.
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Switch Tools Instantly and Model Intuitively Using Poly Haul

Leave tedious modeling tasks behind and say hello to automation! Modo 16.1 introduces artists to
Poly Haul, a collection of commonly used modeling tools that allow artists to seamlessly switch
between a variety of operations without having to drop the tool and select a different one. This
feature is particularly useful when performing a bevel that is inset, automatically deleting geometry
that the bevel crosses.

See Create Complex Models with a Single Tool Using Poly Haul for more information.

Master Curve Workflows with Improved Bezier Controls

Easier Curve Definition with the Enhanced Bezier Tool

Gain greater control over the shapes that can be made using curves with Modo 16.1. This release
brings several enhancements to the Bezier tool. The shortcut keys are now in closer alignment with
Adobe Illustrator’s ones, making Modo workflows more easily interpretable by users. Moreover, when
constraining a Bezier curve to a surface, the handles now align to the surface while the new tangent
controls allow artists to better define how a curve flows into or out of a control point.

See Bezier for more information.

Target Retopology More Effectively with Background Constraint

Use Background Constraints effectively with this addition brought in Modo 16.1. By adding a Target
Item, users can now easily use Background Constraints as they can leave everything in their scene
visible and only define one item to constrain. Artists will be able to work better in context by
retopologizing only a small part of the scene.

See Constraint Target for more information.

Unleash the Power of Curve Modeling with Boolean Enhancements

Greater Flexibility and Control With Primitive Slice Improvements

Added a few versions ago, Primitive Slice can trim a shape using a preset curve, making boolean
operations fast and flexible. But in Modo 16.1, it only gets better—artists can now make use of the
added snapping capabilities, as well as the control handles. Adding details to curves is now much
easier while trimming out detailed shapes is not a challenging task anymore.
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See Creating Geometry on a Mesh Using Preset Shapes for more information.

Complex 3D Shapes Made Easy Using Curve Booleans

With their latest additions brought to you in Modo 16.1, Curve booleans extend their capabilities with
trim open curves and self intersection. While previously curves were closed, now open curves can be
drawn to overlap one another. Similarly, if a closer curve wraps back around itself, self intersection
allows turning it into a single closed shape. Artists have more control over how shapes are created
and can effortlessly create complex 3D shapes from curves.

See Create Complex Procedural Meshes With Curves and Curve Booleans for more information.

Reuse Selections Again and Again with Intelligent Mesh Op Selections

Leverage previous operations to define what you want to select in your procedural modeling
workflow. The new option of Select by Previous Additions allows artists to easily define what is being
selected based on previous operations. Users can reliably use procedural modeling tools and enhance
their modeling workflow.

More Intuitive Falloff Tools for Reliable Modeling

Central to any modeling workflow, Modo’s excellent Selection Tools expand their capabilities even
further with Falloff Weight. Introduced in Modo 16.1, this feature makes it much clearer what actually
is selected and makes it easier to use the Falloff tools just for basic selection, as opposed to the result
of an actual modeling operation. Users can now restore symmetry to a model and create tool presets
for selecting half the model in a more reliable manner.

See Make Selections Fast Using Falloffs for more information.

Better Results from MeshFusion with Geodesic Strip Workflows

Modo 16.1 brings significant improvements to MeshFusion and the way it operates. By adding
Geodesic Strips, MeshFusion is now more reliable and fails less frequently, producing better results in
more modeling cases and making it easier to troubleshoot whenever there’s a problem.

See MeshFusion for more information.

Affect Duplicate Geometry Individually Using Particle Clone

Love Replicators? Modo 16.1 brings something even better—the Particle Clone Operator. While with
Replicators users can’t change or modify just one item, with the Particle Clone Operator they can
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individually edit and modify any of the cloned items. Cloning real geometry, this tool allows artists to
clone a mesh onto particle positions and gives them more granular control over their scenes.

See Duplicate Geometry Using Particle Clone for more information.

Miscellaneous
• ID 281916 - You can now use the F key to find lights and other items in shader tree, similar to the
find function in the Item list.

• ID 348369 - Select by Previous functionality has been added to various mesh operations.

• ID 453697 - New commands have been added to the Bezier Tangent tool to swap tangents between
Smooth and Sharp.

• ID 464315 - Constrain to Background now allows you to select a constrain mesh.

• ID 483832 - MeshFusion: Legacy Strip Corners, Corner Rounding, and Extra Strip Row have been
removed from Properties, but still remain in the Channels list for backward compatibility.

• ID 502669 - A new toggle has been added to turn off the effect of lights in a scene within the
viewport only, without turning off the visibility of the light items.

• ID 504830 - Angle snapping support has been added to all mesh Paint modes. It is activated using
the Shift keyboard shortcut.

• ID 506863 - Lazy Apply has been added to the Primitive Slice tool, improving performance and
snapping. With the option enabled, slicing is suspended during mouse movement and is applied at
mouse up. This makes the tool handle operation smoother and improves element snapping.

• ID 507022 - The Target Mesh option has been added to the Mesh Paint tool.

• ID 510059 - A new Packaged Preset saving option has been added in the Preset Browser, replacing
the Save Assembly Preset option.

• ID 513701 - Primitive Slice now includes an Edit from Center option.

• ID 515094 - GL Transmission Format (glTF) now supports tiling materials.

• ID 518951 - Existing Mesh Operations have been moved to the bottom of the Mesh Operations
Preset Browser for clarity.

• ID 520175 - Images dropped into the environment are now set to Spherical projection automatically.

• ID 520178 - The Locator draw size now defaults to adaptive (0).

• ID 520184 - New preferences to enable and disable array drawing have been added under Display >
OpenGL > Item Drawing.

• ID 520186 - A new keyboard shortcut for Boundary Selection, Ctrl/Cmd+Alt+2, has been added.

• ID 520221 - Pressing Tab now opens the Add Operations list in the Schematic and Mesh Op
viewports.
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Bug Fixes
• ID 397163 - Vertex Bevel created UV islands unexpectedly.

• ID 402254 - mPath: Exit Color did not work as expected.

• ID 402374 - Using Lasso falloff caused the GL count to increase continually.

• ID 480708 - Linux only: .tif textures always rendered in grayscale.

• ID 485483 - Multi-res sculpting performance was slow when compared to legacy versions of Modo.

• ID 486102 - Groups could not be used as stand-in meshes.

• ID 486955 - Edge Chamfer: The Depth control could not be set higher than 100%.

• ID 487814 - The largest smoothing normals did not show hard edges in the viewport as expected.

• ID 491498 - The Script Editor did not save scripts when set to use Python 3.

• ID 493060 - Primitive Slice: Using a Subtract operation on an existing slice with the same depth did
not work as expected.

• ID 494171 - Saving any type of preset in the tree view did not save at the scene overview level and
sub-assemblies were integrated.

• ID 497080 - The default color space was not recognized when a scene was loaded.

• ID 498489 - Rendering stereoscopic scenes using mPath caused Modo to crash.

• ID 498578 - The Help > SDK Developer's Wiki link pointed to the wrong page.

• ID 498901 - Calling any PySide function caused Modo to crash on exit.

• ID 499136 - Transforms with a local action center did not work as expected with Bezier curves.

• ID 500182 - MeshFusion: Tweaking Variable Strips did not update the channel haul as expected.

• ID 501534 - Using Island Align with dense meshes was slow to respond.

• ID 501991 - UV Islands reattached unexpectedly after using the UV Tear tool.

• ID 502156 - Right-clicking a component with nothing selected and then undoing the action caused
Modo to crash.

• ID 502365 - UV Unwrap did not work as expected on detriangulated meshes.

• ID 502368 - UV Unwrap did not work as expected on smooth shift meshes.

• ID 502372 - UV Unwrap did not work as expected on polygon reduced meshes.

• ID 502463 - The results of UV Unwrap for beveled vertices were different between direct modeling
and procedural modeling.

• ID 502854 - Toggling Show Lights with multiple lights in the scene always left one light in the scene.

• ID 503284 - Box snapping corners disappeared when an item was rotated 90 degrees on the Y-axis.

• ID 504484 - Linear falloff did not align with the side closest to the camera as expected.

• ID 504485 - The Contour tool affected geometry behind the camera.
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• ID 505307 - Dragging and dropping a color preset onto a part in the Preview did not apply the color
to the Diffuse Color for that part.

• ID 505922 - Diffuse Color output has the wrong Gamma values when using mPath.

• ID 506866 - Using Tool States caused Modo to become unresponsive.

• ID 507309 - Saving a Material Preset from a Base Material displayed an error.

• ID 507354 - Changing a curve layer input to a Polygon Bevel mesh operation in the Schematic
viewport did not update as expected.

• ID 507357 - Adjusting the positions of the start or end points of a profile curve for the Bridge mesh
operation produced unexpected results.

• ID 507853 - Presets: Opening scenes consolidated on one machine displayed missing LPK warnings
on another machine.

• ID 507917 - Presets: Weight Map General Influences did not save as expected.

• ID 508192 - Dragging a schematic link over backdrop node caused Modo to crash.

• ID 508201 - The Pack UVs tool did not automatically select a UV map by default.

• ID 508232 - Certain scenes containing Curve Boolean mesh operations caused Modo to hang when
the axis of a Circle operation was changed.

• ID 508233 - Using a Scene Item as the source for a Primitive Slice did not work as expected.

• ID 508595 - The Preset Browser occasionally failed to update with newly created presets.

• ID 508687 - Using the Pen tool on a procedural stack mesh caused Modo to crash.

• ID 508874 - Vertex Bevel failed when beveling a vertex connected to two polygons and two edges.

• ID 509083 - The Bridge Mesh operation did not always complete the bridge cleanly.

• ID 509085 - Transfer Vertex Normals showed a new vertex normal map named Other, even if the
target vertex normal map was chosen.

• ID 509272 - Slicing an object caused the tangent directions of polylines to change unexpectedly.

• ID 509425 - UV Unwrap and Relax didn't respecting the Polygon Selection, unwrapping everything on
the mesh.

• ID 509426 - Changing a Length value in certain Mesh Op assemblies caused Modo to crash.

• ID 509495 - Presets: Environment Presets loaded with extra items and shader groups.

• ID 509916 - Align to Normal didn't work with the Sweep Effector if the profile was set to a polyline.

• ID 510044 - Using a Winding Aligner on B-Spline curves broke the shape of the curve.

• ID 510854 - Setting the viewport Catmull-Clark Subdivision Level to 0 also set the render subdivision
level incorrectly.

• ID 511071 - Presets: Applying a Packaged Preset also added an LXP to the Preset Browser.

• ID 511248 - Switching to use Python 3 incorrectly displayed a Python 3 is experimentalmessage.

• ID 511477 - Transfer Vertex Normals from Background did not work as expected in certain scenes.

• ID 511850 - Procedural meshes did not as sources for the Primitive Slice tool.
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• ID 511955 - Presets: Creating a Preset Assembly randomly rearranged existing nodes.

• ID 511976 - Enabling Sharp Corners on the Edge Chamfer mesh operation caused Modo to crash.

• ID 512043 - Expanding the borders in Texture Caching caused Modo to crash.

• ID 512044 - Switching the Left viewport to a Camera twice in a row caused Modo to crash.

• ID 512377 - Using Unbevel in certain scenes caused Modo to crash.

• ID 512390 - Curve Rebuild mesh operations did not output symmetrical results as expected.

• ID 512599 - Evaluating certain Discrete Particle systems caused Modo to crash.

• ID 512772 - Dragging handles multiple times in certain scenes with element falloffs and rig
connections caused Modo to crash.

• ID 512794 - Using the Preset Browser in certain scenes occasionally caused Modo to crash.

• ID 513045 - Polygon Bevel performance was slower when compared to legacy versions of Modo.

• ID 513052 - The Helix Generator count changed, which broke backward compatibility for legacy
scenes and mesh operations.

• ID 513299 - Dimension Tool: Enabling Orient to Selection on heavy meshes caused Modo to
become unresponsive.

• ID 513352 - The Boolean mesh operation Union All produced different results to Union.

• ID 513469 - UV Atlas packing results changed between sessions when the source was a replicator
with multiple prototypes.

• ID 513974 - Transfer Vertex Map used with Vertex Normal Map did not work with certain selections.

• ID 514942 - Pen Knife did not use edge selection as cut guide.

• ID 515164 - Sculpt Tools: The state of the Lock Corners and Lock Borders options was not saved
between sessions.

• ID 515851 - Vertex Coloring failed on certain vertices.

• ID 515929 - UV GrSnap incorrectly rounded to two decimal places.

• ID 516033 - Saving Assembly Preset incorrectly deleted meshes from sub-assemblies.

• ID 516148 - MeshFusion: Vertex Merged Curves with Subtractive Trims caused Modo to crash.

• ID 516547 - The UV Pack Stretch option did not work as expected if some UVs were too small.

• ID 517687 - Calling select.polygonCoplanar : useConnectivity:None didn't work as expected on
multiple layers.

• ID 517779 - UV View GrSnap snapped to both powers of 2 and powers of 10, rather than one or the
other.

• ID 518093 - Edge Subdivide did not work as expected with single edge polylines and curves.

• ID 518550 - Exporting Actors and Actions using Python 3 from the game tools did not work as
expected.

• ID 518591 - Attempting to connect invalid node inputs and outputs in the Schematic viewport
occasionally caused Modo to crash.
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• ID 518606 - Importing certain .fbx files did not assign polygon tags as expected.

• ID 519078 - Adding Merge Meshes to certain scenes caused Modo to crash.

• ID 519109 - Disabling Use Clip UDIM and changing the horizontal and vertical repeat to Edge when
manually positioning a single image on a UV offset the UV incorrectly.

• ID 519352 - The search field in the Preset Browser always retained the previous search entry.

• ID 519373 - Duplicating a Mesh Operation placed the duplicate under the original.

• ID 519377 - Duplicating a Mesh Operation also duplicated its selection operations.

• ID 519523 - Calling schematic.setView -1 in new scenes occasionally caused Modo to crash.

• ID 519582 - The Curve Sweep Select by Previous > Caps option did not selects all curve caps as
expected.

• ID 519656 - Duplicate shortcut did not always work in the item list.

• ID 519971 - The drop_Recognisemeta class displayed a TypeError exception.

• ID 519975 - In certain scenes, disabling items the Schematic viewport caused Modo to crash.

• ID 520123 - In automaticmode, the PBR loader did not set the colorspace correctly.

• ID 520187 - Mesh Ops automatically linked to unselected meshes incorrectly.

• ID 520188 - The Curve Sweep scale gradient did not default to 100% as expected.

• ID 520189 - Creating a new vertex map on a procedural mesh incorrectly created the map on the
base mesh, rather than failing.

• ID 520222 - Pressing Ctrl/Cmd+D did not duplicate Mesh Ops in Componentmodes as expected.

• ID 520413/520414 - Curve Extrude and Pen Extrude did not allow extrusion of multiple curves.

• ID 520588 - Importing an .lwo file and then closing the scene caused Modo to crash.

• ID 521719 - Editing Cylinder lights in a live Preview caused Modo to crash.

• ID 522215 - Swapping the left viewport to theModel layout and then closing it caused Modo to
crash.

• ID 523101 - Using Edge Subdivide across multiple layers caused Modo to crash.

• ID 523185 - Undoing and redoing combinations of tool activations occasionally caused Modo to
crash.

• ID 523196 - Using the Transform keyboard shortcut (W) followed by the Channel Haul keyboard
shortcut (C) and then undoing the action caused Modo to crash.

• ID 524233 - Converting meshes with VMaps to Static Meshes caused Modo to crash.

• ID 524388 - Selecting a Mesh Op and group locator hid some Properties unexpectedly.

• ID 524551 - Selecting an operator in a Mesh Op stack and then selecting ghost mode caused Modo to
crash.

• ID 526696 - Alignment in the Curve Sweep tool did not work as expected.
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Known Issues
This section covers known issues and gives workarounds for them, where appropriate.

Animation
• ID 423909 - Grease Pencil - Setting image type to JPG results in a black fill over the screen.

• ID 395357 - Deformer Caching doesn’t work.

• ID 240321 (53661) - Selecting actions does not always select the correct one. This is caused by
copying actions.

Note: As a workaround, manually edit the tags on the broken actions by selecting them in
the Groups tab, then save and reload the scene.

Assemblies
• ID 288164 (36452) - Assemblies exported from the Item List context menu result in poor visual layout
of nodes on import.

Note: As a workaround, you can save assemblies from the Schematic viewport.

Baking
• ID 293020 (50671) - Baking displacement maps can cause UV seams to be visible, and the baked
displacement map to show quilting effects and other render artifacts.

• ID 221481 (49437) - The Bake Channel Swizzling option can’t bake to texture alpha.

Bucket Render
• ID 297021 (52730) - The Vertex Illumination Bake command doesn't work as expected, when the
mesh has transform channels.

Note: As a workaround, freeze the transforms in the mesh properties.
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• ID 292947 (53184) - Value presets created for material Subsurface Scattering samples in Modo 10.1
or earlier now show on the render item instead.

• ID 279848 (55663) - Motion Blur applied on a curve in a Mesh Operation no longer works.

• ID 243070 (53793) - Rendering using a Dual CPU with 72 threads was significantly slower than
expected.

Note: As a workaround, any machine that has more than 32 cores, performance will be
better if you limit rendering to half the number of cores you have.

• ID 235368 (53411) - Mesh lights or any direct light too close to a surface can produce fireflies (hot
pixels) in some cases.

Note: As a workaround, use a Maximum Radiance higher than 1 W/srm2 to reduce the bias.

Color Management
• ID 221439 (49244) - Windows only: With Perform Color Correction on, setting a default scene to a
scene with a mesh that has a position channel crashes Modo at launch.

Note: As a workaround, use System > Reset Preferences to reset to defaults or
move/remove the default scene.

Command Line
• ID 289290 (49514) - macOS only: Running modo_cl before running the UI Modo application breaks
code signing.

Note: As a workaround, start the UI version of Modo once, before running modo_cl on any
system where you later intend to use the UI version.

File and Image I/O
• ID 346842 - Alembic import - Drag/drop doesn't import animation correctly.
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Note: As a workaround, use File > Import.

• ID 337523 (56862) - Modo for SolidWorks Kit: Modo crashes when importing the same SolidWorks
file twice in one Modo session. This only affects import using the kit, not direct imports (File >
Import).

Note: As a workaround, before importing a SolidWorks file for the second time, exit and
restart Modo.

• ID 226589 (49728) - Exporting selected layers (from the Item List context menu) to .fbx doesn't
export instances, unless the original mesh is also exported.

Note: To resolve this, set the .fbx preference to Export Selection and use the Export As…
option.

• ID 221508 (50198) - Alembic scenes don't export some surface items, including static meshes and
procedural shatter items.

• ID 220991 (47036) - Color management in .svg images is not currently supported. This is a side-effect
of a fix where the largest allowable image size (64k x 64k) was always used when color correction
was enabled.

• ID 220975 (46962) - Rendering .svg images used as stencil maps for displacement or for layer
masking can be very slow.

Fur
• ID 288248 (35731) - Fur length textures can’t be edited with the Stretch tool.

Note: Use different fur length drivers, such as hair guides or vector vertex maps.

Input Devices

Note: SpaceBall support is scheduled for deprecation in Modo 17.0 and will not be
supported in subsequent releases.
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• ID 303287 (35856) - Linux only: Plugging in a Wacom tablet while Modo is running can cause
undesired movement. This cannot be fixed, due to a limitation of the hardware driver.

Note: To avoid this, plug in the tablet before application start up or restart.

• ID 226536 (51741) - macOS only: Modo sometimes becomes unresponsive when using the
combination of a click-drag in a tree view (for example, when toggling the visibility of two successive
items in the Shader Tree), followed immediately by a two-finger scroll gesture on some devices,
including laptop trackpads and the Magic Mouse.

Note: As a workaround, change to a 3-button mouse (recommended to fully access all of
Modo's features).

MeshFusion
• ID 527533 - We have removed the Fusion Slicer 7Point assembly from built-in content as it causes a
crash when used with other important improvements to MeshFusion.

• ID 316276 (56973) - If a Trim Fusion role is assigned to an object and then it is dragged and dropped
onto a Primary, the drop menu does not contain the Trim Boolean options.

Note: As a workaround, use either the Fusion Buttons (Tool palette - Set Mesh Role &
Apply section) or Pie Menu (Apply SubtractionApply Intersection or ) when initially adding
Trims to each Fusion Item (Trims can contribute to multiple Fusion Items). If initially applied
with either of those methods, all subsequent Drag & Drop options will be supported.

Modeling
• ID 533267 - Primitive Slice: Lazy Apply sometimes fails to update correctly.

• ID 533072 - Poly Haul: Switching modes fails to apply the current state with Select Through enabled.

• ID 528159 - Poly Haul: There is currently an offset issue with symmetry.

• ID 408278 (60027) - Linear Falloff snaps to object size.

Note: As a workaround, use the right mouse button for an interactive initial linear handle.

• ID 226970 (32728) - Zooming out with a Space Navigator alters the Work Plane position.
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Network Rendering
• ID 226337 (36986) - Workers render hidden meshes. Since mesh hide state is not stored in the scene,
when that scene is transferred to the workers, the state is lost. The master respects the hidden state,
however.

Note: As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or
render or open System > Preferences > Rendering and disable Use Network Render
Nodes.

• ID 226363 (48325) - Scenes with image sequences rendered with Full Frames use the wrong image
sequence number on worker machines.

Note: As a workaround, use File > Consolidate Scene, then render the scene using a
shared network folder (Preferences option under Rendering > Network Rendering).

• ID 226336 (25636) - Frame passes are not supported.

• ID 220955 (30318) - Network Rendering doesn’t support Realflow particles.

• Several bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not
implemented to support baking. Changes to Modo in the 10-series apparently broke what was
working for some artists, so the functionality has been disabled.

Note: As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items
and an external render controller. For more information, please see the SDK Wiki.

Nodal Shading
• ID 385250 - Nodal Shading is slower in 13.0 with some modifiers.

• ID 221393 (50642) - Nodal shading does not support UDIMs.

Painting/Sculpting
• ID 532498 - Clicking Utilities > Add Displacement Texture incorrectly sets the Blend Mode to Add.

• ID 532220 - Sculpt mask painting does not drawing instantly on a mesh as expected.
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• ID 288461 (41682) - Textures are not always updating in Preview/Render when painting on an image
map.

Note: You can save and reload the image to force the update.

Particles
• ID 303192 (34925) - Re-opening scenes saved with large particle caches can cause problems.

Note: To avosuch issues, delete the cache before closing Modo, or export the particles to
.csv cache files or Realflow .bin files. You can do this by attaching one of those nodes to the
Particle Simulation item in the Schematic viewport, and clicking Cache Simulation.

Preview Render

• If a high poly mesh is not visible, the Preview baking output will be incorrect.

Note: As a workaround, reset Preview to fix the baking.

• ID 524623 - Surface Probe Texture: Modo will crash with two Previews running.

Presets
• ID 242621 - Assembly Preset Aliases will crash when certain connections are made to them. If any of
these are inside of an assembly alias that is collapsed, then you can potentially hit a crash: Replicator
Item, Array Operator modifier, Falloff Operator, Selection Operator, Particle Operator, Any kind of
texture (images, procedural textures, etc)

Note: As a workaround, expand the assembly alias, as evaluating those types of items for a
non-aliased assembly should still work fine.

Procedurals
• ID 484639 - Select by Material Tag doesn't work with Mesh Op stack.

• ID 450059 - Lace Guides produce overly twisted polygons on the deformation points.
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Note: As a workaround, change the Normal Method on the Curve Sweep to automatic to
eliminate the twisting.

• ID 388978 - Paving does not work when a Guide curve runs through a paving hole

• ID 305303 (56318) - Procedural duplication of Mesh Ops in a Deform folder creates errant Mesh Ops
list.

• ID 305302 (56317) - Duplication of Procedurals does not work with the Select By Previous Operation
tool.

Note: As a workaround, manually edit the duplicate's Select By Previous Operation Mesh
Ops.

• ID 289810 (46512) - When rigged, Rock items and other procedurals do not display correctly in GL.
This is a limitation of the feature and will not be fixed.

Note: You can use Preview or RayGL to visualize the variations from rigging.

• ID 266469 (54738) - A duplication of any item that is a Merge Meshes Source (For example, a Mesh
Item, Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to the Merge
Meshes Ops List as a source.

Note: As a workaround, remove the unwanted additional Merge Mesh Sources (regardless
of the type of source) in the Mesh Ops List using the X icon in that list next to each Merge
Meshes source.

• ID 221355 (52149) - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal
option doesn't work when using a Bezier with zero-length tangents.

Note: As a workaround, rotate the polygons to point toward the +Z before extruding or
make sure there are no zero-length tangents.

References
• ID 309252 (56620) - Modo crashes when closing a scene containing a referenced scene after
attempting to revert a reference override.
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Note: As a workaround, first close and reopen the scene before attempting to revert the
reference.

• ID 294394 (44492) - If a scene that already contains references is referenced, the shading of the
original references may not persist.

Note: As a workaround, limit scenes with shading to one level of reference.

• ID 220957 (41119) - Reloading a reference after replacing it with the same file can cause Modo to
crash.

Retopology
• ID 533555 - Using retopo guides with Autoretopo occasionally causes Modo to crash.

Rigging
• ID 483457 - Disabling or hiding connections using the H keyboard shortcut causes the stack order to
behave erratically.

• ID 404238 - Bezier Curves don’t work correctly with the Curve Falloff.

• ID 287584 (27244) - Duplicating joints in a bound mesh retains influences from the original joint
chain.

Scripting
• ID 242545 (53458) - Right-clicking or running a script in the Script Editor can lock up input to Modo.

Note: As a workaround, click in the top window of the Script Editor, use the main menus, or
change to another application, then switch back to Modo.

Shader Tree

Note: The Archvision RPC plug-in has been deprecated in Modo 16.1. As a result, the RPC
Mesh Item and RPC Texture shader are no longer available.

• ID 526275 - Surface Probe Texture renders incorrectly when using Embree or OptiX with mPath.

Release Notes for Modo16.1v1 | Known Issues



RELEASE NOTES
22

Note: To workaround this issue, use the SSE ray tracing engine when using the Surface
Probe Texture.

• ID 385991 (57874) - Custom Materials that define their own smoothing properties (such as the Skin
material), no longer smooth the mesh correctly.

• ID 299187 (37858) - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip
browser) fails.

Note: To work around this issue, in the Clip Browser, choose a single image instead of the
group, and then change to the image group using the Texture Layer's Properties tab.

• ID 288141 (30947) - Layer masking displacement does not work unless you drag and drop the
masking layer onto the displacement layer.

Unreal and Unity Materials
• ID 295862 (50700) - There is no way to visualize the Unreal SubSurface Color effect in Modo.

• ID 294747 (50701) - Unreal material Ambient Occlusion does not bake correctly in Modo.

• ID 221477 (50451) - On some graphics cards, Unity material may cause flickering in the Advanced
viewport when used with bump maps and shadows.

UI
• ID 525565 - Linux only: Webengine and Intro Screen do not work as expected.

• ID 395884 - Mac only - Double-clicking bottom right corner or edge of popover doesn't resize back
the popover correctly.

• ID 388937 - macOS only: UI form field highlights can appear gray.

• ID 333249 (57715) - Selecting items in the viewport does not always update the Properties form.

Note: As a workaround, click the alt key.

• ID 288714 (43162) (Windows only) -Setting a custom text size affects Modo's text drawing.

Note: As a workaround, go to the compatibility settings by right-clicking the Modo shortcut
or executable, and turn off font-scaling for the application.
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• ID 281374 (55759) - Transforming objects can cause the Items Properties panel to flicker.

• ID 277244 (55571) - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.

• ID 273139 (55185) - Text in the viewport icon buttons is not visible in the Advanced viewport on some
macOS/AMD configurations.

Note: As a workaround, upgrade Mac OS to 10.13.

• ID 226492 (44496) - macOS only: Disabling Affect System Color Dialog in Preferences > Rendering >
Color Management, and using the system color picker caused colors to darken with each use of the
color picker.

Note: This is due to an OS X issue, which requires the color profile in both the monitor
settings and color picker to be set to sRGB IEC61966-2.1.

• ID 224169 (44896) - Dragging and dropping an image from disk into the Clips list doesn’t work.

Note: If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it
above or below other images in the list.

Viewports

• ID 514563 - Setting AVP Transparency to Correct and Correct Transparency Mode to Full
occasionally causes the NVIDIA driver to crash.

• ID 478549 - Saving Alpha with Playblast is just completely white.

• ID 420733 - Ghost Mode Transparency set to 0% isn't fully transparent.

• ID 408416 - Gradient (texture layer) renders incorrectly in the Advanced Viewport.

Note: As a workaround, use Preview.

• ID 310930 (56706) - Unity and Unreal materials are not displayed correctly when first loaded into the
Advanced viewport.

Note: As a workaround, enable and then disable the visibility of the Shader Tree textures.
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• ID 338374 (58003) - Game Navigation mode (camera rotation) does not work in a floating 3D view
(palette or separate window).

Note: As a workaround, use Game Navigation mode only in docked 3D views (views that are
part of a Layout).

• ID 338599 (57955) - Clicking on the VR layout tab may crash when using a system with a Radeon WX-
series graphics card. This is due to a driver and should be fixed by a AMD in a future driver release.

• ID 289738 (49473) - Projections are incorrect if the projecting camera is set to Vertical film fit mode
and the width is less than the height.

• ID 289020 (43771) - Camera projections from non-render cameras show distortion in GL and baking.

Note: To avoid this, make sure that the projection camera has a film width-to-height ratio
that matches the main render camera.

• ID 281365 (55816) - Wireframes are washed out on transparent surfaces in the Advanced viewport.

Note: As a workaround, avoid transparency when modeling or doing work where
wireframes are needed. Alternatively, use the Default viewport.

• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any
unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in
the Shader Tree.

• Windows only: Using Raptr can cause GL driver crashes in Modo.
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